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Overview

Thus far, we have relied on the tools to configure the Zynq PS properly. Although it
wasn’t explicitly pointed out previously, performing a Run As or Debug As operation in
SDK first sources the ps7_init.tcl file that was created during the export to SDK. In
a true, embedded application, you will not have a JTAG cable connected that can
transfer these settings. Your code must be able to do this before transferring control to
an application. The code that sets up the Zynq PS is called the First Stage Boot Loader
(FSBL).

Objectives

When this tutorial is complete, you will be able to:
e Create the FSBL
e Prepare the boot image
e Write and boot from QSPI
e Write and boot from the microSD Card
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Experiment Setup

Software

The software used to test this reference design is:
e Windows-7 64-bit
e Xilinx SDK 2015.2
e Silicon Labs CP201x USB-to-UART Bridge Driver
O www.microzed.org = Support = Documentation = MicroZed
Silicon Labs CP210x USB-to-UART Setup Guide
0 Note that MicroZed and the PicoZed FMC Carrier both use the same
Silicon Labs CP2104 device, so the setup is the same.
e Tera Term or another terminal emulator
0 We will be booting outside of the SDK environment, so we will use an
external terminal as well.
0 For additional information on setting up Tera Term, see the USB-to-UART
Setup Guide listed above.

Hardware

The hardware setup used to test this reference design includes:
e Win-7 PC with the following recommended memory*:
0 1.6 GB RAM available for the Xilinx tools to complete a XC72010 design
0 1.9 GB RAM available for the Xilinx tools to complete a XC72020 design
0 2.7 GB RAM available for the Xilinx tools to complete a XC72030 design
e One of the following:

O Avnet MicroZed 7010 or 7020

0 Avnet PicoZed 7010, 7015, 7020, or 7030 with the PicoZed FMC Carrier
e USB cable (Type A to Micro-USB Type B) — one included in kit
e JTAG Programming Cable (Platform Cable, Digilent HS1, HS2, or HS3 cable)

0 |Ifyou don’t already have a JTAG Cable, Avnet recommends the Digilent
HS3 Cable

0 http://www.em.avnet.com/jtaghs3

e microSD card — one included in kit
e microSD card adapter — SD form factor adapter included in kit

1 Refer to www.xilinx.com/design-tools/vivado/memory.htm
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Experiment 1. Create the FSBL

The first step is to create the FSBL application. This is a C program that embeds all the
Zynq internal register settings that were established during the Vivado Block Design.

Similar to the flow for creating the Hello_World application, in SDK create a First Stage
Bootloader application.

1. Launch SDK and open the workspace from the Hello World project.

2. File > New = New Application Project

www.microzed.org Page 3 of 16
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3. Name it something like ZED_FSBL and Create New BSP. The reason for creating a
new BSP is that the FSBL BSP requires a library for the Flash, and the tools will
automatically include this for us if we allow it to create the BSP. Click Next

@ MNew Project L@ﬂ
Application Project »
Create a ranaged rmake application project. \E
Project name:  ZED_FSBL|
Uze default location
ChAvnet\Microf ed\Applications\MZ_Basic_System\ZED_FSE Browse...
default
05 Platform: [standalone v]
Target Hardware
Hardware Platform: [hw_platform_ﬂ vl ’Nm]
Proceszon [ psf_cortexad 0 - ]
Target Software
Language: @ C () C++
Board Su;%ort P g @ Create New  ZED_FSBL_bsp
() Use existing | standalone_bsp_0
@:l < Back l Mext = I [ Finish J l Cancel
Figure 1 — FSBL Application
www.microzed.org Page 4 of 16
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4. Select Zynq FSBL

5. Click Finish
B MNew Project E@g

Templates .
Create one of the available templates to generate a fully-functicning @
application project.

Available Templates:
Peripheral Tests First Stage Bootleader (FSEL) for Zyng. -
Dhrystone The FSBL configures the FPGA with HW
Ermnpty Application bit stream (if it exists) and loads the
Helle Warld Operating Systern (05) Image or
IwlP Echo Server Standalene (54) Image or 2nd 5tage Boot
Mernory Tests Loader image from the non-velatile
R5A Authentication App memeory (NAMD/MOR/QSPI) to RAM
SREC Bootloader (DDR) and starts executing it. It supports
SREC SPI Bootloader multiple partitions, and each partition
Zilkernel POSIX Threads Demo can be a code image or a bit strearn.

Zin? DRAMN tests

@ Net> [ Fnish | [ Cancel

Figure 2 — Zynq FSBL Template for Application
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Experiment 2: Prepare the Boot Image

The next step is to create a non-volatile boot image. MicroZed and PicoZed + FMC
Carrier both have two non-volatile, primary bootable sources, QSPI and SD Card.

1. In SDK, select Periph_Test.

™ Project Explorer &3

- == Hello_7ed

> g hw_platform_0

+ 25 Mem_Test

. [ =5 Periph_Test

> @ standalone_bsp_(
. == ZED_FSBL

) @a ZED_FSBEL_bsp

. =% ZyngDRAM_ Test

Figure 3 — Select Application to Boot

2. Select Xilinx Tools > Create Zynq Boot Image.

m C/C++ - ZED_FSBL bsp/system.mss - Xilinx SDK

File Edit Scurce Refactor Mavigate Search Project | Xilinx Tools | Run Window Help

C = | o % TR @ ' | @ Repositories

lil, Board Support Package Settings
. = Generate linker script
L5 Project Explorer &3 B || system.k B .
= <& = 22 Program FPGA
&Y ZED_FSE
. == Helle_Zed E Program Flash
. E hw_platform_0 Dump,/Restore Data File
. 125 Mem_Test @
. [ Periph_Test [g XMD Conscle
> @ standalone_bsp_0 Target Inf ‘ #5DB Conscle
] '[EC- ZED_FSBL This Board E Launch Shell

> @ ZED_FSEBL_bsp

15 ZynaDRAM Test Hardware Et Create Zyng Boot Image

Tar 38 System Generator Co-Debug Settings
Configure QEMU Settings

(Operating

Figure 4 - Create Zynq Boot Image
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This will preload the FSBL ELF, bitstream, and Application ELF images. The order of the
files is important. The FSBL is first, followed by the bitstream, followed by the
Application. One function of the FSBL is to program the PL. After the PL is configured,
the application is loaded.

Boot image partitions

File path Encrypted Auther
(bootleader) ChAvnet\MicroZed\Applications\MZ_Basic_System’\ZED_FSBL\Debug\ZED_FSBL.elf none none
ChAvnet\MicroZed\Applications\MZ_Basic_System‘\hw_platform_0\System_wrapper.bit none none
Chlvnet\MicroZed\Applications\MZ_Basic_System'\Periph_Test\Debug\Periph_Test.elf none none

Figure 5 — Boot Image Partitions

Notice that by default, the output path points to BOOT.bin (highlighted), which is the
bootimage required for SD boot. We will create this one first, and then we will need to
repeat the operation for the QSPI bootimage (mcs).

Ef Create Zynq Boot Image [ = |

Create Zynq Boot Image
Creates Zynq Boot Image in .bin and .mcs formats from given FSBL elf and partition files in specified output folder. @

@ Create new BIF file () Import from existing BIF file
Output BIF file path:  C\Avnet\MicroZed\Applications\MZ_Basic_System'\Periph_Test\bootimage\Periph_Test.bif

[7] Use Authentication
Authentication keys

Browse Browse
Browse Browse
Browse
[] Use encryption
Encryption key:
Browse
@ BRAM EFUSE
Boot image partitions
File path Encrypted Auther| | Add
(bootloader]. C:\A\rnet\l\fli.c ro;ed\Applicat.ions\MZ_Basic_S)rstem\ZED_FSBL\Debug\ZEI;J_FSBL.elf none none
ChAvnet\MicroZed\Applications\MZ_Basic_System‘hw_platform_0\System_wrapper.bit none none
ChAvnet\MicroZed\Applications\MZ_Basic_System"Periph_Test\Debug'\Periph_Test.elf none none
4 I * w
Output path: ChAvnet\MicroZed\Applications\MZ_Basic_System\Periph_Test\bootimage\BOOT.bin
@j ’Preview BIF Changes] [ Create Image ] [ Cancel ]

Figure 6 — Create Image

www.microzed.org Page 7 of 16
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3. Click Create Image.
4. Select Xilinx Tools 2> Create Zynq Boot Image again.

5. Click Browse next to the Output Path. To keep things consistent, browse and
select the previously used bootimage directory.

C:\Avnet\MicroZed\Applications\MZ_Basic_System\Periph_Test\bootimage

6. Change the Save as type to *.mcs. Type in Periph_Test for the File name and
then click Save.

m Output file ﬁ

@n\;‘;v| . <« MZ _Basic_System » Penph_Test » bootimage - |<F?|| Search bootimage ol

Organize * Mew folder 4= - (7]

. MicroZed oy MName Date modified
,Xil
. Applications
, MZ_Basic_System
J .metadata
| Hello_fed
| hw_platform_0
; Mem_Test
. Periph_Test

Mo iterns match your search.

. bootimage
. Debug

. Release — = n

File name: Periph_Test -

Save as type: |*.mcs vl

= Hide Folders [ Save ] [ Cancel ]

Figure 7 — Set Bootimage Output File to Periph_Test.mcs

www.microzed.org Page 8 of 16
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The resulting Bootimage dialog is shown below. Notice that we do not need to re-

generate the BIF file since it was created when BOOT.bin was generated.

m Create Zynq Boot Image

Create Zynq Boot Image

Creates Zynq Boot Image in .bin and .mcs formats from given FSBL elf and partition files in specified output folder.

() Create new BIF file @ Import from existing BIF file

Import BIF file path:  Ch\Avnet\MicroZed\Applications\MZ_Basic_System'\Periph_Test\bootimage\Periph_Test.bif

Qutput BIF file path: ChAvnet\MicroZed\Applications\MZ_Basic_System\Periph_Test\bootimage\Periph_Test.bif

[ Use Authentication
Authentication keys

[T Use encryption
Encryption key:
(@ BRAM EFUSE

Boot image partitions

Browse

Browse

1l =9

m

rowWse

m

roOwWse

m

rowse

File path Encrypted Authenti| | Add
(bootloader) ChAvnet\MicroZed\Applications\MZ_Basic_System\ZED_FSBL\Release\ZED_FSBL.elf none none
Chlvnet\MicroZed\Applications\MZ_Basic_System‘\hw_platform_0"System_wrapper.bit none none
ChAvnet\MicroZed\Applications\MZ_Basic_System'\Periph_Test\Release'\Periph_Test.elf none none
q 1 ¢ | | Down

Qutput path: ChAvnet\Microfed\Applications\MZ_Basic_System'\Periph_Test\bootimage\Periph_Test.mcs
@:J [Preview BIF Changes] [ Create Image ] [ Cancel ]

Figure 8 — Creating the QSPI Bootimage
7. Click Create Image.
www.microzed.org Page 9 of 16
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8. Using Windows Explorer, navigate to the application directory, then into
Periph_Test, then into the newly created bootimage directory. Notice that
three files have been created: .bif, .bin, and .mcs. These are all the required files

to program either the QSPI or SD Card.

| . v Computer » O5(C) » Avnet » Microded » Applications » MZ_Basic_System » Periph_Test » bootimage

ew Tools Help

Include in library - Share with = Burn MNew folder

, Mem_Test . Mame ’

EI . Periph_Test - .

. & BOOT.bin

i i | bootimage . .
|| Periph_Test.bif
- 1. Debug .
: || Periph_Test.mcs
- Release

. SFC

Figure 9 - bootimage Directory

www.microzed.org
www.picozed.org

Date modified Size

6/29/2015 5:07 PM 2,201 KB
6/29/2015 5:07 PM 1KB
6/29/2015 5:08 PM 6,182 KB
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Experiment 3: Write and boot from QSPI
First, we will program the QSPI with the MCS file from within SDK.

1. Set up the MicroZed or PicoZed for Cascaded JTAG mode as before. Attach the
JTAG cable. Power on.

2. In SDK, select Xilinx Tools = Program Flash.

3. Click the Browse button, and browse to the MCS image for the application you
wish to program. Select it and click Open. You can selectively enable the Blank
check after erase and/or the Verify after flash functions although each of these
will add time to the procedure. Neither is required to program the Flash.

4. Click Program.
-

Program Flash Memory

Program Flash Memory via In-system Programmer,

=i

Hardware Platform: ’hw_platform_ﬂ vl
Connection: ’Local v] [ Mew ]
Device: Auto Detect
Image File: ChAvnet\MicroZed\Applications\MZ_Basic_System\Periph_Test\bootimage\Periph_Test.mes
Offset:
Flash Type gspi_single vl
Browse
Convert ELF to bootloadable SREC format and program
[T]Blank check after erase
[ Verify after flash
@:‘ [ Program l [ Cancel

Figure 10 — Program QSPI Flash Memory

5. The operation took approximately 140 seconds on a Win7 PC with a Digilent HS2
JTAG Cable for a 7010. You should see the following in the Console window.

www.microzed.org Page 11 of 16
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CortexA9 Processor Configuration

L L=« BxBBaa88e 3
T ExBaaaaane
No of PC Breakpoints....eosesenuanas 6

Mo of Addr/Data Watchpeoints......... 4
Processor Reset .... DONE

Performing Erase Operation...

Erase Operatiocn successful.

Performing Program Operation...

5
...Program Operation successful.

Flash Operation Successful

Figure 11 — QSPI Programmed Successfully

6. Power off the board. The JTAG cable may be unplugged.
7. Set the Boot Jumpers to QSPI

a. MicroZed: move JP3 to the 2-3 position.

w

-

Figure 12 — MicroZed QSPI Boot Mode

b. PicoZed: set the boot mode switch SW1 to QSPI mode as shown below.

Figure 13 — PicoZed SOM SW1 Set to QSPI Boot
7010/20 on the Left; 7015/30 on the Right

www.microzed.org Page 12 of 16
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8. Close or disconnect the terminal that may have previously been open on your

PC.

9. Power on the board. The blue DONE LED should both be lit.

10. Launch a terminal program (TeraTerm) with the 115200/8/n/1/n settings.

11. Push the RST button. You should see the results in the terminal.

COM4:115200baud - Tera Term VT

File Edit Setup Control Window Help

———Entering main——

Running ScuGicSelfTestExample<?» for ps?_scugic_B...
BcuGicSelfTestExample PASSED
BcuGic Interrupt Setup PASSED

RBunning BDmaPs_Example W _Inte<> for ps? _dma_s...
Test wround 8
BWDmaPs_Example_YW_Intr PASSED

Running Interrupt Test for ps?_ethernet_@...
EmacPszDmalntrExample PASSED

Running QspiSelfTestExamplel? for psV_gspi @...
QzpiPsSelfTestExample PASSED

Running DefgSelfTestExampled) for ps?_dev_cfg @...
DecfgSelfTestExample PASSED

Running ScuTimerPolledExample<» for ps7?_scutimer_B. ..
BcuTimerPolledExample PASSED

Running Interrupt Test for ps?_scutimer_@...
SculimerIntrExample PASSED

Running Interrupt Test for ps?_scuwdt_B8__.
SBculldtIntrExample PASSED

Running Interrupt Test for ps?_ttc_@...
TtcIntrExample FASSED
F—Exiting main——

Figure 14 — Results from QSPI boot of Periph_Test

12. Close the terminal. Power off the board.

www.microzed.org
www.picozed.org
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Experiment 4: Write and boot from the microSD Card
Next, we will prepare the microSD card with the bin file that SDK generated.

1. To program a microSD Card, insert the microSD card into an adapter and plug
into your PC. Copy the BOOT.bin image to the microSD Card.

2. Be aware that the name “boot.bin” is essential. If you changed the name of the
.bin file, rename it on the microSD card to boot.bin or BOOT.bin. THIS IS
CRITICAL!

3. Eject the microSD card from the PC.

4. Insert the microSD card into the board slot.

5. Set the Boot Jumpers to SD Card:

a. MicroZed: both JP2 and JP3 in the 2-3 position
JP2 JP1-
. “iRka}
Figure 15 — MicroZed SD Card Boot Mode
b. PicoZed: set the boot mode switch SW1 to SD mode as shown below.
Figure 16 - PicoZed SW1 Set to SD Boot
7010/20 on the Left; 7015/30 on the Right
www.microzed.org Page 14 of 16
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6. Close or disconnect the terminal that may have previously been open on your
PC.

7. Plugin the USB-UART cable.
8. Launch a terminal program with the 115200/8/n/1/n settings.

9. Push the RST button. You should see the same results in the terminal that were
shown during the QSPI test.

www.microzed.org Page 15 of 16
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Revision History

Date Version Revision
26 Aug 2013 | 2013_2.01 | Initial Avnet release for Vivado 2013.2
06 Sep 2013 | 2013_2.02 | Switching to Release build rather than Debug
10Jun 2014 | 2014 _1.01 | Update to 2014.1. Added instructions that .bin and .mcs
must each be generated individually now.
11 Jun 2014 | 2014_2.01 | Update to 2014.2. Bitstream must manually be added to
the Boot Image dialog now.
29 Jun 2015 | 2015_1.01 | Update to 2015.1. Bitstream is no longer manual. Add
support for PicoZed.
15Jul 2015 | 2015 _2.01 | Update for 2015.2
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